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LaScala Installation and User’s Manual 

Copyright and Disclaimer  

The information in this documentation was prepared by Sanbolic, Inc. with reasonable care and is believed to be accurate. However, 
Sanbolic, Inc. shall not assume responsibility for losses or damages resulting from any omissions, inaccuracies, or errors contained 
herein. Sanbolic, Inc. may make improvements or changes in this documentation or in the product and programs described in this 
documentation, at any time and without notice and as it sees fit. This publication describes the state of this product at the time of its 
publication, and may not reflect the product at all times in the future. 

No part of this documentation may be reproduced, stored in a retrieval system, or transmitted, in any form or by any 
means, electronic, mechanical, by photocopying, recording, or otherwise, without the prior written permission of 
Sanbolic, Inc. 

SANBOLIC, INC. MAKES NO WARRANTY EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, REGARDING THESE 
MATERIALS AND MAKES SUCH MATERIALS AVALIABLE SOLELY ON AN "AS-IS" BASIS. 

IN NO EVENT SHALL SANBOLIC, INC. BE LIABLE TO ANYONE FOR SPECIAL, COLLATERAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING OUT OF 
PURCHASE OR USE OF THESE MATERIALS.  

The End-User Software License Agreement, which is included with the software program and this manual, specifies the permitted and 
prohibited uses of the software program.  

Please read the terms and conditions of the Agreement before commencing use of the software program. 

© Copyright Sanbolic, Inc., 2002-2004. All rights reserved. 

Printed in the USA 

 

Trademarks 

Sanbolic and Sanbolic logo are registered trademarks of Sanbolic, Inc.  

LaScala and LaScala logo are registered trademarks of Sanbolic, Inc.   

Third-Party Trademarks: 

Windows 2003 and 2008 are trademarks of Microsoft Corporation. All other brand names, product names or registered belong to their 
respective holders. 
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End-User License Agreement 

 
IMPORTANT NOTICE TO END-USER . PLEASE READ THE TERMS AND CONDITIONS OF THIS 
AGREEMENT CAREFULLY. 
 
THIS SOFTWARE LICENSE AGREEMENT (“AGREEMENT”) IS A LEGAL AGREEMENT BETWEEN 
END-USER AND SANBOLIC, INC. (“SANBOLIC”) FOR USE OF THIS SOFTWARE, INCLUDING THE 
ASSOCIATED PRINTED, ONLINE, OR ELECTRONIC DOCUMENTATION, CD-ROM MEDIA, COPY-
PROTECTION HARDWARE, AND ANY AND ALL COPIES OF AND MAINTENANCE RELEASES TO 
THE SOFTWARE, AS WELL AS ANY THIRD-PARTY SOFTWARE EITHER EMBEDDED IN OR 
OTHERWISE INCLUDED AS PART OF THE SOFTWARE (“SOFTWARE”). BY INSTALLING, 
COPYING, OR USING THIS SOFTWARE, END-USER IS DEEMED TO HAVE ACCEPTED AND 
AGREED TO THE FOLLOWING: 
 
1. GRANT OF LICENSE AND LIMITATIONS.  In consideration for payment of the applicable license fees, 
SANBOLIC grants to END-USER and END-USER accept a personal and non-exclusive license to use the 
Software in object-code format, including the associated documentation, subject to the terms, conditions, and 
restrictions of this Agreement. END-USER may install a copy of the Software on a single computer owned, 
leased, or otherwise controlled by END-USER solely for its internal purposes. If END-USER wishes to make 
concurrent use of the Software on two or more computers, END-USER must acquire a license for each separate 
machine. END-USER agrees not to modify, adapt, translate, decompile, disassemble, or otherwise reverse 
engineer any portion of the Software, except and only to the extent expressly permitted by applicable law. 
END-USER may not sell, loan, lease, sublicense, or distribute the Software, or otherwise create derivative 
works based upon the software. Prior to disposing of any media containing the Software, END-USER agrees to 
erase or otherwise destroy any Software stored on such media. This license does not grant END-USER any right 
to any enhancements or new versions of the Software. Any such enhancements or new versions, if available, 
may be obtained by END-USER at SANBOLIC’s then current standard pricing, terms and conditions. 
 
2. OWNERSHIP OF SOFTWARE. All title, rights, and interests in and to the Software and underlying 
intellectual property rights in the Software are and shall at all times remain the valuable property of 
SANBOLIC or its suppliers. END-USER acknowledges that the Software contains valuable trade secrets or 
confidential and proprietary information of SANBOLIC, and that use of the Software does not transfer any title 
to or rights of ownership in the Software to END-USER. END-USER shall not remove or alter SANBOLIC’s or 
its supplier’s copyright, trademark, or other proprietary notices and legends included in the Software. END-
USER agrees to take reasonable steps to prevent any unauthorized access, disclosure, distribution, possession, 
alteration, transfer, reproduction, or use of the Software. SANBOLIC and its suppliers reserve all rights not 
expressly granted to END-USER under this Agreement. THE SOFTWARE IS PROTECTED BY 
INTELLECTUAL PROPERTY LAWS AND INTERNATIONAL TREATIES. THE SOFTWARE IS 
LICENSED TO END-USER AND IS NOT SOLD. 
 
3. BACKUP COPIES. END-USER may make one (1) copy of the Software for security backup and archival 
purposes. END-USER shall place the same copyright and other proprietary notices and legends that appear on 
the validly licensed copy of the Software in any such backup copy. 
 
4. TRANSFERS. SANBOLIC shall have the right to assign its rights and obligations hereunder in whole or in 
part. END-USER may permanently transfer all of its rights and obligations under this Agreement to a third-
party transferee provided that (i) END-USER transfers a validly executed assignment and assumption of its 
rights and obligations with respect to the Software; (ii) END-USER does not retain any copies of the Software 
or prior versions or upgrades, enhancements, or updates to the Software; (iii) END-USER provides SANBOLIC 
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with notice in writing of the transfer and the name, address and contact person for the transferee; and (iv) the 
third-party transferee accepts in writing the terms and conditions of this Agreement. Except as provided for 
above, END-USER may not transfer or assign this Agreement or any of its rights or obligations under this 
Agreement without the prior written consent of SANBOLIC, and any such unauthorized transfer shall be null 
and void. 
 
5. LIMITATION OF WARRANTIES.  Sanbolic warrants that the storage media on which the Software is 
furnished will be free from physical defects in materials and workmanship under normal use for a period of 
thirty (30) days from the date of delivery to END-USER, and that such storage media shall contain a complete 
copy of the Software. Any other software and any hardware furnished with or accompanying the Software is not 
warranted by Sanbolic. As the sole remedy for any breach of the foregoing warranties in this paragraph, 
Sanbolic will replace any and all such defective media with media free from defects and containing a complete 
copy of the Software. 
 
EXCEPT AS STATED ABOVE IN THIS SECTION, THE SOFTWARE IS (AND ANY SERVICES OR 
SUPPLEMENTS NOW OR HEREAFTER PROVIDED WITH RESPECT TO THE SOFTWARE ARE) 
PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-
INFRINGEMENT AND FITNESS FOR A PARTICULAR PURPOSE.  SANBOLIC AND ITS SUPPLIERS 
SPECIFICALLY DO NOT WARRANT THAT THE FUNCTIONS OR FEATURES OF THE SOFTWARE 
WILL MEET ALL OF THE END-USER’S REQUIREMENTS; WILL OPERATE IN ALL THE PRODUCT 
COMBINATIONS WHICH MAY BE SELECTED FOR USE BY THE END-USER; THAT THE 
OPERATION OF THE SOFTWARE WILL BE ERROR-FREE OR UNINTERRUPTED; OR THAT ERRORS 
OR DEFECTS IN THE SOFTWARE WILL BE CORRECTED.  THE ENTIRE RISK AS TO THE QUALITY 
AND PERFORMANCE OF THE SOFTWARE (OR ANY SERVICES OR SUPPLEMENTS NOW OR 
HEREAFTER PROVIDED WITH RESPECT TO THE SOFTWARE) IS WITH THE END-USER.  TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, END-USER EXPRESSLY WAIVES ALL 
WARRANTIES OR CONDITIONS NOT SPECIFICALLY SET FORTH HEREIN. SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES AND CERTAIN OF THE ABOVE 
EXCLUSIONS MAY NOT APPLY TO END-USER. NO AGENT, DISTRIBUTOR, OR RESELLER IS 
AUTHORIZED TO MAKE ANY ADDITIONAL WARRANTIES OR MODIFY THE FOREGOING 
LIMITED WARRANTY. 
 
6. LIMITATION OF LIABILITY.  IN NO EVENT SHALL SANBOLIC OR ITS SUPPLIERS BE LIABLE 
FOR ANY SPECIAL, PUNITIVE, INDIRECT, CONSEQUENTAL, OR ANY OTHER DAMAGES, 
INCLUDING, BUT NOT LIMITED TO, LOSS OF PROFITS, LOSS OF REVENUE, LOSS OF USE, LOSS 
OF DATA, PROPERTY DAMAGE, OR ANY OTHER COMMERCIAL OR ECONOMIC LOSS OF ANY 
KIND ARISING OUT OF THIS AGREEMENT, OR THE USE OR PERFORMANCE OF THE SOFTWARE, 
OR THE RESULTS OBTAINED THROUGH USE OF THE SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE, OR FOR ANY CLAIM BROUGHT AGAINST END-USER BY ANY 
OTHER PARTY, NOR SHALL SANBOLIC OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES 
WHATSOEVER RESULTING FROM ANY ACT BEYOND ITS REASONABLE CONTROL. TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW. ANY LIABILIT Y OF SANBOLIC OR ITS 
SUPPLIERS FOR DAMAGES ARISING FROM EITHER THIS AGREEMENT, OR THE END-USER’S USE 
OR PERFORMANCE OF THE SOFTWARE, UNDER ANY LEGAL THEORY, WHETHER IN 
CONTRACT, TORT, NEGLIGENCE, STRICT LIABILITY OR OTHERWISE SHALL BE LIMITED 
EXCLUSIVELY TO REPLACEMENTOF THE SOFTWARE OR REIMBURSEMENT OF THE AMOUNT 
OF THE LICENSE FEES PAID BY END-USER FOR THE SOFTWARE, AT SANBOLIC’S SOLE OPTION. 
END-USER AGREES THAT THIS LIMITATION OF LIABILITY SHALL ALSO APPLY TO AND 
BENEFIT SANBOLIC’S SUPPLIERS, DISTRIBUTORS, OR RESELLERS. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OR LIMITATION OF SPECIAL, INDIRECT, INCIDENTAL, OR 
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CONSEQUENTIAL DAMAGES, AND THE ABOVE LIMITATION AND EXCLUSION OF LIABILITY 
MAY NOT APPLY TO END-USER. 
 
7. TERMINATION.  Without prejudice to any of its legal rights and remedies, SANBOLIC may terminate this 
Agreement if END-USER fails to comply with the terms and conditions of this Agreement. In the event of any 
such termination, END-USER shall discontinue all use of the Software, and return to SANBOLIC all copies of 
the Software in its possession. 
 
8. NOTICE TO U.S. GOVERNMENT USERS. If END-USER is a unit of the United States Government, the 
Software and associated documentation are provided with restricted rights. Use, duplication, or disclosure by 
the United States Government is subject to the restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or the restrictions set forth in (c)(1) and 
(2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable, or in 
successor provisions, including the limitations set forth herein. Manufacturer is Sanbolic, Inc., 304 Pleasant 
Street, Watertown, Massachusetts, U.S.A. 
 
9. MISCELLANEOUS.  SANBOLIC and END-USER further agree that (i) this Agreement shall be 
constructed in accordance with and governed by the laws of a Delaware Corporation applicable hereto, without 
regard to its conflict of law rules; (ii) the parties expressly exclude the application of the United Nations 
Convention on Contracts for the International Sale of Goods, and any local or international law, convention, or 
regulation which may provide an alternative law or construction, to the extent such waiver shall be permitted by 
applicable law; (iii) if any term of this Agreement is deemed void and unenforceable, the remainder of this 
Agreement shall remain valid and enforceable; (iv) in the event of conflict between the terms and conditions of 
this Agreement and END-USER’ s purchase order, quotation, or other equivalent, the terms of this Agreement 
shall be controlling. No conflicting term or condition contained in any purchase order, quotation or other 
equivalent, shall be binding upon SANBOLIC in any fashion without SANBOLIC’s written consent; (v) the 
parties consent to this Agreement being drawn up in the English language; and (vi) this Agreement may not be 
amended except in a writing executed by both parties. 
 
10. ENFORCEABILITY.  END-USER acknowledges that this Agreement is binding and shall entitle 
SANBOLIC to enforce the above terms. END-USER further agrees that SANBOLIC suppliers referenced in the 
Software are intended beneficiaries to this Agreement, and, to the maximum extent permitted by applicable law, 
may enforce this Agreement as it relates to their intellectual property rights. 
 
11. EXPORT RESTRICTIONS. END-USER may not export or re-export the Software except in full 
compliance with applicable export controls laws and regulations, and unless a validated export license is 
obtained from the applicable regulatory agencies, as required. 
 
12. ACKNOWLEDGEMENT.  END-USER has read, understands, and agrees to be bound by the terms and 
conditions of this Agreement. IF END-USER IS NOT WILLING TO BE BOUND BY THE ABOVE TERMS, 
THE UNUSED SOFTWARE MAY BE RETURNED FOR REFUND OF THE LICENSE FEES PAID TO 
SANBOLIC OR THE DISTRIBUTOR OR RESELLER FROM WHICH END-USER ACQUIRED IT, 
PROVIDED THAT THE SOFTWARE IS RETURNED FOR REFUND WITHIN THIRTY (30) DAYS 
AFTER DELIVERY. PLEASE CONTACT THE VENDOR FROM WHICH YOU OBTAINED THE 
SOFTWARE FOR REFUND AND REFUND INSTRUCTIONS. 
 
 
 
 
Sanbolic, Inc., 2000. All Rights Reserved. 
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Installation and Setup of LaScala 
 
LaScala is a cluster volume manager that incorporates many of the technologies used in Melio FS. It allows 
multiple hosts to manage large disk sets comprised of disks located on one or more disk arrays and supports 
centralized and remote management, disk groups and dynamic (online) volume creation and expansion. 

 
Minimal System Requirements 

·  Pentium II class CPU 
·  256 MB RAM 
·  5 MB disk space 
·  LAN (TCP/IP) connection 
·  SVGA – min. 800x600, 256 colors 
·  Shared storage connected via Fiber Channel or iSCSI, but other interfaces are possible as well. 

 
Supported Operating Systems  
 

·  Windows Server 2003 x64 
·  Windows Server 2003 R2 x64 
·  Windows Server 2008 x86, x64 
·  Windows Server 2008 R2 

 
Note: Support for Windows Server 2003 x86 and Windows Server 2003 R2 x86 is no longer available. 
 
LaScala requires TCP/IP protocol and Microsoft .NET framework version 2.0 (free download from Microsoft at  
http://www.microsoft.com/downloads/details.aspx?FamilyId=262D25E3-F589-4842-8157-034D1E7CF3A3 ). 
 

Recommendations 
 

·  LaScala employs a proprietary communications protocol (based on TCP and UDP) for cluster volume 
management. To ensure that communications between LaScala nodes are not affected by intermittent 
network issues, Sanbolic strongly recommends providing a dedicated network (i.e., VLAN or switch) 
for LaScala cluster volume traffic. This network should be completely isolated from the rest of the LAN. 
 

·  Note: LaScala does not support NIC teaming/bonding. Please ensure that the network interface assigned 
for LaScala cluster volume management traffic is not teamed with another network interface. 
 

·  To simplify the management of and achieve greater performance from shared storage, Sanbolic strongly 
recommends using Sanbolic LaScala cluster volume manager to manage Melio FS shared volumes. 
Designed for shared SAN storage, LaScala allows administrators to create basic partitions, volume sets 
and stripe sets and supports dynamic (online) volume expansion. 
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Installation Checklist 

·  Install Microsoft .NET framework 2.0. .NET framework 2.0 is integrated into Windows Vista, but must 
be installed on all previous versions of Windows. .NET framework 2.0 is a free download from 
Microsoft, available via Windows Update or from: 

 
For X86 .Net framework 2.0 RTM: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=0856eacb-4362-4b0d-8edd-
aab15c5e04f5&DisplayLang=en  

 
For X64 .Net framework 2.0 RTM: 
http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-AFFB-
40E78D788B00&displaylang=en 

 
·  Install your storage hardware, per the vendor's instructions. Make sure the hardware is functioning 

without errors. Check the System event log for error messages and resolve all issues before proceeding. 
 

·  During the installation of LaScala, Windows Management Instrumentation (WMI) and Windows 
Management Instrumentation Driver Extensions services are started. Stopping or disabling either of 
these services will prevent LaScala from functioning properly. 

 
·  Check if all machines that will take part in the SAN have functioning network connections and are able 

to establish TCP/IP network connectivity amongst one other. LaScala uses both TCP and UDP protocols 
on the default port of 7778. If necessary, this port can be changed (must be changed on each node 
participating in the cluster). 
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Installation and Configuration 

Start the provided setup program and follow the instructions displayed on the screen. 
 

When prompted to enter a Machine User Account, enter the account name using the format displayed in the 
screen below and enter the password for the account. 
 
Note: LaScala uses a more complex security model. If you are not familiar with it, please read the Security and 
Troubleshooting sections. 
 
In the screen below, LaScala is installed on the machine called test-2-2k3 and the machine user is called 
La_Scala_Machine (the local computer name\user name is circled in red). The local computer name\user name 
identifies the machine from which LaScala is run and its access rights. The computer name\user name can later 
be changed from the User Interface of LaScala. 
 
 

 
 
Note that you must enter an account, which exists in “Local Users and Groups” for the machine on which you are 
installing LaScala, or in the domain. If the account exists neither in Local Users and Groups, nor the domain, you must 
create it prior to installing LaScala. If you choose to use local machine accounts to represent Machine User Accounts, 
you can use the same user name (for instance La_Scala_Machine, machine_user, etc) on every machine in the domain 
and since the computer names are different, they will be different agents.  
 

To create a new local machine account, right-click on My Computer and select Manage. This will open the 
Computer Management console. Navigate to Local Users and Groups and open Users. Now check if the account 
exists and if it does not, create it. The screen should look similar to the one displayed on the following page. 
 
Since the La_Scala_Machine account is automatically granted “Log on as a service” privilege, we recommend 
this account be given the minimal necessary rights (i.e., user rights only). 
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The setup procedure installs a driver that is the core of LaScala. Wait for Windows to install the driver. Depending 
on your operating system and settings, you may receive a Security Alert indicating that the driver being installed is 
not digitally signed. Click “Yes” to install the driver. 
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After the driver is installed, you will be asked to choose a Trial or Full version. The Trial version is a time-
limited Full version that is fully-functional and expires in 14 days. If you choose Full version, the next screen 
will prompt you for the registration key. 
 
The last phase of the installation appears only if you have Windows Firewall enabled and running. In this case, 
a pop-up window asks if you would like to add TCP and UDP ports 7778 in the port exceptions of the Windows 
firewall. Click “Yes.” 
 
Note: If the servers are unable to communicate with one other, they will not form a functional cluster. 
 
Important:  Prior to using LaScala, go to the Network Card Properties. In the Power Management tab, uncheck 
the option “Allow the computer to turn off this device to save power ” and click “OK.” 
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Usage 

Before you can create volumes, you have to select the disks that LaScala will manage. You can only manage free 
disks (disks without partitions) that are in an offline state* under Microsoft Windows Server 2008/2008 R2 family. 
This does not apply for machines running Windows Server 2003/2003 R2 as there is no such option in the user 
interface. Please also note that the 128 MB Unallocated space in the beginning of a LaScala managed volume is 
normal and expected. 
 

 
 
* Managing only free disks, or disks without partitions, which are in an offline state introduces another level of 
protection as managing a disk requires formatting, which deletes all information on the disk. 
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Managing a disk  
 

Right-click on the disk label on the left-hand side of the lower window pane and select “Manage” or “Manage 
Multiple” to manage more than one disk. 
 

 
 

A pop-up window will appear asking you to select the disk(s) that you want LaScala to manage. There are 
additional options, which are explained later in this manual. Select the disks to manage and click “OK.” 
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After the disks are managed, the following screen is displayed. 
 

 
 
To create a partition on a managed disk, right-click on the disk and select “New.” 
 

 
 

Select the desired partition size by entering numbers in the “Size” field or using the red slider bar. 
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When this step is completed, the new partition (displayed below in blue) is added in the tree view in the upper 
left-hand window pane. A blue partition indicates that the partition has not been physically created. 
 

 
 
To create the partition, select “Action > Apply Changes” from the toolbar or press F3. 
 

 
 

A pop-up window will be displayed asking for confirmation. Click “Yes.” 
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Once the changes are committed to the disk, the color of the partition will change to black, indicating that the 
partition has been created. 
 

 
 

Now the partition can be converted to a volume that can be accessed by Windows. 
 
To convert the partition to a volume, right-click on the partition in the tree and select "Create Logical Drive…” 
 

 
 

A dialog window will appear asking you to assign a drive letter to the new volume (see screen on following 
page). The setting "Try to set this letter, if available, on each machine that has access to the volume" means that 
LaScala will attempt to supply Windows with the same drive letter for this volume on all machines that will be 
sharing access to the volume. In cases where the drive letter is already in use by a machine, LaScala will supply 
that particular machine with the next available drive letter for this volume. 
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It is also possible to mount a LaScala volume on an empty Melio FS or NTFS folder using mount points. To 
mount a volume on an empty folder, check the radio button labeled “Mount to an empty folder” and enter the 
path to the folder. 
  
From the Initial Security settings you can choose to allow access to this volume by only this machine or by 
everyone. 
 

Note: If you have Melio FS installed on this computer, the option to format this volume with Melio FS will be 
selected by default. 
 
You can also enter a label for the volume in the “Volume Label” field. This field is optional. 
 

 
 
After clicking OK to confirm your selections, the volume will be presented to Windows. Windows will discover 
the new device and ask you to install the drivers for it. Select the automatic installation option. 
 
Note: If Windows prompts you to restart the machine, click “Cancel” as restarting the machine is not necessary. 
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Depending on the operating system, you may receive a warning message about a non-signed driver being 
installed. Click “Continue Anyway” to proceed with the driver installation. 
 

 
 
After the installation of the volume is complete, Windows will prompt you to restart. Click “Cancel” as there is 
no need to reboot the machine. 
 
Notice: Disks that cannot be managed are displayed as 'Unknown' or “Foreign.” To manage an unknown disk, 
you need to stop it from being managed by Windows Logical Disk Manager (LDM) by deleting all partitions on 
that disk. If the disk is dynamic, convert it to basic using Windows LDM. 

Creating a Stripe Set 
On your storage controller, create all the partitions that will be included in a stripe set. Note that the partitions 
making up the stripe set must be exactly the same size. Right-click in any open area in the top left window pane 
and select “New-> Stripe Set.” 
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A pop-up window will be displayed, asking for the size of the stripe set. By default, the stripe size is set to 64 
Kbytes, which corresponds to the default stripe size of most contemporary disk arrays. 
 

 
 

A new empty placeholder for the stripe set will appear. 
 

 
 

Add the partitions to the stripe set by left-clicking on them (one at a time) and dragging and dropping them onto 
the stripe set. 
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From the toolbar, select “Action > Apply Changes” to create the stripe set. 
 

 
 

To make the stripe set visible to Windows as a volume, follow the steps described previously to create a logical 
drive (see page 18). 

Creating a Volume Set 
To create a volume set, follow the same steps used to create a stripe set, only this time, right-click on any empty 
space in the upper left-hand window pane and select “New > Volume Set.” 
 
Note: Unlike stripe sets, the partitions making up a volume set do not have to be the same size. 

Extending a Volume 
To extend a volume, it must have a mounted file system that supports extension (i.e., Sanbolic Melio FS). 
Follow the instructions provided previously to create a new partition, volume set or stripe set, apply the changes 
and drag and drop the new partition/volume set/stripe set onto the logical drive that you want to extend. Apply 
the changes to extend the volume (logical drive). After the changes have been applied, the extended volume will 
be displayed as a volume set. 
 
Note: You cannot extend a volume set that contains only basic partitions with a Stripe set. This is due to the 
different sector size of the partitions and the stripe set. 
 
Note: Shrinking a volume is not supported. 

Extending a Disk 
If you run out of free space on a disk, you may be able to add additional free space (provided there is unused 
storage resources available and the storage hardware supports adding disk space) through your storage manager. 
These changes will take effect in LaScala on the fly – without reboot. From the toolbar at the top of the LaScala 
management interface, select “View > Rescan disks” or press Ctrl+Shift+F5. 
 
Note: Shrinking a disk is not supported. 
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Rescan Volume Mount points 
To rescan the volume mount points from the View menu select “Rescan volume mount points.” 

Deleting a Volume 
Select the volume and press the [Delete] key or right-click on the volume and choose "Delete" from the menu. 
The operation is completed only after you apply the changes (“Action > Apply Changes”). 

How to unmanage a volume  
Delete all volumes, stripe sets, volume sets and basic partitions residing on the disk. Right-click on the LaScala 
managed disk. From the context menu select “Unmanage…” or “Unmanage multiple…”. A pop-up window 
will appear. Use the check box to select the disk(s), you want to delete and click “OK.” After the changes are 
applied, the disk(s) will be displayed as “Not-managed”.* 
 
*Note: On slower machines, the disk may appear as “Foreign.” Refresh the disks by opening the context menu 
in the directory View and select “Refresh Disks” or use the Ctrl+F5 shortcut key combination. 
 
LaScala Settings 

There are two types of adjustable parameters in LaScala - settings that affect the machine as a whole and 
settings that are applied on a per disk basis. 
 

"Driver Settings" guides the general behavior of LaScala on a machine. To access Driver Settings, select View 
> Driver Settings from the toolbar at the top of the LaScala management interface. 
 

 
 
The following screen will be displayed: 
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The “Network” tab is used to confirm or change the network interface assigned for cluster volume traffic. 

 
"IP Address" is the address LaScala uses to communicate with other instances of the software around the 
network. The default value of 0.0.0.0 means LaScala will listen to all available IP addresses in the system. You 
can safely leave it this way when your system has only one IP address. When it is necessary to specify the 
precise address LaScala must use, this parameter must be changed. 
 
"Port" is the TCP and UDP port LaScala uses for communication. If you have a firewall that is blocking this 
port, you can change the value here. Make sure you change this value on all machines running LaScala, 
otherwise they will not be able to establish connection and volumes will not be accessible by all machines. 
 
"Connection timeout" specifies how long LaScala will wait for a reply before it assumes its counterpart is 
"dead". 
 
The “Strip Set” tab shows the block size LaScala uses for reading/writing data. The default value for the block 
size is 64KB, which is consistent with the block size used by Windows operating systems. 
 
The “LaScala Service” tab is used to confirm or change the account used by LaScala to manage volumes. 
 
There are also settings that apply to each separate physical disk in the system. To access these settings, right-
click on the label of a disk and select "LaScala Properties." The following screen will be displayed. 
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"Max I/O Time" is the time LaScala will wait for an input/output operation to complete. If the operation is not 
completed in this allotted period, LaScala assumes there is some problem with the disk (i.e., the disk is 
disconnected). 
 
"Heartbeat Period" is the time interval used by LaScala to check that the other machines in the cluster are 
accessible. 
 
"Max Net Roundtrip" and "Max OS Response Delay" are used when the disk is discovered for the first time 
and added to the cluster of LaScala machines, or when this machine itself enters a cluster of other LaScala 
machines. These parameters determine how long it will take for the machine to enter the cluster. 
 
Note: If you need to change the timings of more than one disk at a time, select “Set Cluster Timings 
Multiple…” and a pop-up window will be displayed, allowing you to select the desired disks. 
 

 
 

Security 

Since LaScala is a volume manager, it is important to remember that security permissions can be applied to a 
volume only and not to disks, partitions, mirrors, stripes, etc. A volume is the resource for which users are 
granted access. Like any other protected object in Windows, each volume has a security descriptor defining 
users’ access to it. When security can be applied to a particular object, the respective option in the context menu 
is enabled. 
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Agents 
Two agents can operate with volumes:  

1. A machine user account represents the machine from where the volume is accessed. The credentials of 
the machine user account are necessary in order to start the LaScala service. The rights of the machine 
user account define: 
 
        a. Whether the volume will be visible on a particular machine or not and 
        b. If the volume is visible, what access rights are enabled for it: read only, write only, or read/write. 
 

2. A common user (John, Mary, etc.) - These are the people who make changes, edit configurations, etc. 
For making changes from the User Interface of LaScala, the credentials of the common user apply. 

Most likely, the machine user account is the account entered during the installation of LaScala. If this account 
or its credentials need to be changed, you can do it from the LaScala Service tab of the Global Settings dialog. 
 

    
 
Default Security Settings 
 
The screenshots above illustrate the initial security of a volume - one machine user account and one common 
user. By default, after a volume is created, it has the following default security settings:  

·  Full access rights (both Read and Write Access) for the machine from where it is accessed 
·  Full control for the common user who has created it 

This means that if a volume must be accessible from several machines, it will be visible only for the first one, 
while the rest of the machines will have neither Read, nor Write access to it until those rights are explicitly 
granted (i.e. a mark is put in the respective check boxes). After the machine user account gains access to the 
volume, the security rights for the common users who will access it from the respective machine can be applied. 
From that point on, the volume will be accessible to other users from other machines. 
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To add a new user, click the Add button to open the Select Users or Groups dialog box. Adding users and 
setting permissions will not be explained here because it does not differ from the standard Windows procedure.  
 
The screenshots above show all possible rights enabled for both users. Common users (in this case 
Administrators) can change the size of volumes, change the letter assigned to a volume, delete volumes, etc., if 
they access the volume from a machine for which Read and Write access has been enabled.  
 
Machine user permissions are Machine Read Access and Machine Write Access. There are four scenarios: 

1. The machine user account has no access to the volume, if there are no marks in both checkboxes. 
In this case, the volume will not be visible to common users who log in from this machine. Thus these 
users will not be able to make any changes to the volume. If a volume cannot be seen in LaScala, one 
possible reason is that it is not visible from the machine from which it is being accessed. 
 

2. The machine user has Read access, if only the Machine Read Access is checked. In this case, the 
volume will be visible, but nobody who logs into this machine will be able to write to it.  
Important Note:  When Machine Read Access is enabled, it is possible to delete the volume, so long as 
there is a mark in the Delete checkbox for the respective user! 
 

3. The machine user account has Write access, if only the Machine Write Access is checked. This 
option is used when it is necessary to write data to the volume (backups, daily reports, etc.) without 
being able to view the other data in the volume (i.e., confidentiality reasons). 
 

4. The machine user account has full control (both Read and Write access), if both the Machine 
Read Access and Machine Write Access are checked. In this case, common users who log into this 
machine will be able to make changes to the volume as defined in their common user security profile. 

Security Operations 
There are three basic types of security operations that can be performed on a volume: 

1. Structure modification (creating new stripe sets, partitions, etc.) 
2. Deleting a volume  
3. Changing security permissions and ownership of the resource 

Note about Machine User Accounts Representation 

Unfortunately, Windows does not have a notion for “Machine User Account”, it knows only about “user 
accounts”.  So how does LaScala create the special “Machine user accounts”? The answer is simple – it 
does not make special accounts, it just uses the Windows user accounts. The administrator is responsible 
for assigning every machine an account dedicated solely to the task of identifying the machine so LaScala 
can distinguish it from the other machines connected to the same storage array. 

Representing Machine User Accounts with Local Computer Accounts 

If, for example, the computers participate in a workgroup, the administrator can create a separate security account 
on every machine. During LaScala installation this account will be assigned as the “Machine User Account”. 

Let’s say we have a workgroup of three computers, named Aurora, Venus and Janus. Prior to installing 
LaScala, the administrator creates a user account called “Aurora \LaScala_Machine_User”. During the 
installation of LaScala, when the administrator is prompted to enter a machine account, he or she enters 
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“Aurora \LaScala_Machine_User”1 as the Machine User Account, along with its respective password, 
and continues the installation. 

Next the administrator installs LaScala on Venus machine. He or she creates the account 
“Venus\LaScala_MachineUser” and when installing LaScala, enters “Venus\LaScala_Machine_User” as 
the desired Machine User Name. On the Janus machine the desired Machine User Name could be 
“ Janus\LaScala_Machine_User”. 

There is a caveat, though. When using accounts on local machines, every machine knows only about its 
accounts and the other accounts are represented using the internal Windows SID. Although this does not 
impair LaScala’s functionality, it can be confusing in the beginning. 

 
 

Representing Machine User Accounts with Domain Accounts 

If you are a domain administrator, the second possible scenario is to use domain accounts as Machine User 
Accounts. For instance, there are three computers in the domain. The computers are named Emerald, Ruby, and 
Sapphire, respectively. The domain controller is called Diamond and the domain itself is MyCompany.com. 
The administrator can choose to follow the workgroup security model, described above. However, the more 
flexible way is to create separate domain accounts dedicated to representing LaScala “Machine User Accounts”, 
i.e., “MyCompany\Emerald_LaScala”, “MyCompany\Ruby_LaScala”, and 
“MyCompany\Sapphire_LaScala”. Now, the administrator installs LaScala on Ruby. When prompted to enter 
Machine User Name, he or she enters “MyCompany\Ruby_LaScala” and the associated password. When the 
administrator installs LaScala on Emerald, the Machine User Account would be 
“MyCompany\Emerald_LaScala”. On the Sapphire machine, the Machine User Account would be 
“MyCompany\ Sapphire_LaScala”. 

                                                 
1  Windows imposes a restriction - the name is limited to 20 characters only. Even if you manage to enter more, only the first twenty 
characters will be applied. 
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The “Log on as a service” Privilege 

 It is worth noting that the Windows security account used by LaScala is used only to check security rights of 
the machine it represents and nothing more. So, using the Windows terminology, this account must have the 
“Log on as a service” privilege enabled. If it does not have this privilege, the installation checks whether this 
account has the “Log on locally” privilege, and if it succeeds, grants it the “Log on as a service” privilege. The 
internal service, which logs on to Windows using this account, does not modify the file system on any 
computer or on the disk array and does not write to the registry. So the Windows user account representing the 
LaScala “Machine User Account” can (and should) have very limited rights: it can be a member of the “Users” 
or “Domain Users” group, the administrator can safely deny it rights over file systems and the registry, etc. 

LDM disks 

Volumes, partitions and disks created by Windows Logical Disk Manager are seen in LaScala VM. You may change 
drive letters and paths, format LDM volumes with Melio FS or delete them. To change the drive letter or format or 
delete an LDM volume, right-click on the volume in the LaScala user interface and select the appropriate function. 
 

 
 

In order to avoid deleting the system drive, it is colored in red and the delete and format functions are not allowed. 
 

 
 
LDM dynamic disks are not compatible with LaScala and appear as “Unknown” in the LaScala user interface. 
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Uninstall 

Uninstall LaScala via "Add/Remove Programs" or "Add/Remove Software" in the Windows Control Panel. 
Follow the onscreen instructions and reboot your computer to complete the uninstall procedure. 
 

How to Request Technical Support 
The address for technical support requests is support@sanbolic.com. When you submit a support request, please 
follow these guidelines. 
 
1. Supply information on your hardware and software  
2. Supply the version of LaScala  
3. Describe the steps to reproduce the problem  
4. Supply event logs  
5. Supply the exact error message   
6. Specify how many times the problem has occurred  
7. State the actual results  
8. Outline the expected results 
 

1. Supply information on your hardware and software  
 

Use the All programs-> Accessories-> System tools -> System information or any other product that will 
provide details about the software and hardware running on the system. 
 
Please describe the configuration of your central storage. Specify the type and speed of the connection to the 
hosts, the type of the disk array - JBOD or RAID, the model of the hard disks. Also describe the RAID 
controller, the RAID level, type of RAID (hardware/software), what software provides the RAID functionality 
(Windows or third-party). Describe the topology of your storage network (i.e., how many hosts, how many disk 
arrays, how many loops, etc.). 
 

2. Supply LaScala Version  
 

The version of LaScala can be obtained by looking in the system event log. LaScala shows its version in an 
information message in the system event log. The version can also be determined by looking at the version of 
the driver LaScala.sys, which is located in %windir%\system32\drivers. 
 
Please make sure that you run the same version of LaScala on all your machines. If for some reason this is not 
the case, please state the version of LaScala running on each of the machines. 
 

3. Describe the Steps to Reproduce the Problem  
 
Please write down the exact steps that lead to the particular problem. If we cannot reproduce the problem, it will 
be more difficult to identify, investigate and fix whatever is causing the problem. 
 
Due to the distributed nature of LaScala, additional information may be required. Take notes regarding the order 
in which the machines were started, which corresponds directly with the order they enter the cluster and also 
affects some other aspects of LaScala operation. 
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4. Supply Event Logs 

 
Please send the appropriate event logs from your system. LaScala writes its information in the System event log 
and in a custom LaScala volume management log. Other software (e.g. MS SQL) enters important information 
in the Application event log. Please supply the event logs in native (binary) format, not as text files. To do so: 
 

·  Launch Event viewer (Start menu > Run… > type ‘eventvwr’ without the quotes) 
·  Select System Log, from the ‘Action’ menu select ‘Save Log File as…’ Make sure the type of the file is 

“Event Log (*.evt(x))”. 
·  Select “LaScala Volume Management log” from Applications and Services logs, from the ‘Action’ 

menu select ‘Save Log File as…’ Make sure the type of the file is “Event Log (*.evt(x))”. 
 
To further help Sanbolic support, please provide as much information as possible from the log files. It is also 
helpful to state the approximate time the issue occurred. 
 

5. Supply the Exact Error Message  
 

If an error message is displayed in a message box, write down the exact text of the message. If the message is in 
another language, please translate the message in English. Also you may perform a screen capture of the error 
message as follows: 

 
·  Make sure that the error message is the active window. Press Alt+PrtScn to place a bitmap copy of the 

window in the Clipboard.  
·  Open the built-in MS Paint bitmap editor, and paste the image.  
·  Then go to "File->Save as" and choose a filename. 

 
In case a STOP error occurs that leads to a "blue screen of death", it is important to obtain the kernel memory 
dump that should be created at %SystemDrive%:\Windows\Memory.dmp. If you have made some analysis or 
suspect it may be LaScala related, please compress and upload it via the file manager in your account at 
http://clients.sanbolic.com. Then contact support@sanbolic.com with a problem description according to the 
steps in this section. We will analyze the dump and provide suggestions according to our findings. 

 
6. Specify How Many Times the Problem Occurred   

 
The best property a problem may have is to be reproducible every time a particular test is run. Unfortunately 
this is not always the case. If something occurs only once, it will be very difficult to determine the cause. 
 
Please specify the frequency in which a particular issue is occurring and the steps taken to reproduce the issue 
consistently. 

 
7. State the Actual Results  

 
When possible, please describe the exact results achieved during the test using quantitative values. For example, 
the statement "Windows Explorer stopped responding. We waited for X minutes and nothing changed, so we 
had to kill the explorer process." is much more informative than the statement “The machine hangs.” 

 
8. Outline the Expected Results  

 
Please describe the test results you expected in detail. 
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Contacting Sanbolic 

Sanbolic, Inc. 
Support contact: support@sanbolic.com 
Information requests: info@sanbolic.com 
Sales inquiries: sales@sanbolic.com 
Web site: www.sanbolic.com 
 
Mailing address:� 
Sanbolic, Inc. 
304 Pleasant Street 
Watertown, MA 02472 
USA 

 


